Copyright

LexisNexis, Lexis, and the Knowledge Burst logo are registered trademarks of Reed Elsevier Properties Inc., used under license. Canadian Legislative PULSE is a trademark of LexisNexis Canada Inc. Other products and services may be trademarks or registered trademarks of their respective companies.

Copyright © 2015 LexisNexis. All rights reserved.
Contents

Introduction .................................................................................................................. 1

Configuration Issues ................................................................................................. 2
  Required Browser: .................................................................................................. 2
  Logging In: ............................................................................................................. 2
  Bookmarking: ......................................................................................................... 2
  Java Requirement: .................................................................................................. 2
  JavaScript Requirement: ......................................................................................... 3
  Cookies: .................................................................................................................. 3
  Pop-up Windows and Pop-up Blockers: ................................................................. 3
  Firewalls: .............................................................................................................. 4
  Proxy Servers: ........................................................................................................ 4
  Usernames / Passwords: ....................................................................................... 5
  Screen Resolution: .................................................................................................. 5

Profile Passwords ...................................................................................................... 5
  Adding: ................................................................................................................. 6
  Modifying/Deleting: ............................................................................................... 6

Navigating the Site ..................................................................................................... 7
  Main Menu: .......................................................................................................... 8
  Table of Contents: ................................................................................................. 9
  Menu bar: ............................................................................................................. 10

Legislation .................................................................................................................. 11
  Layout of Bills: ..................................................................................................... 11
  Accessing Legislation: ............................................................................................ 12
  Symbols and Colours: ............................................................................................. 12
  Menu Bar for Bills Pages: ..................................................................................... 13
  Full Text Links: ..................................................................................................... 14
  Other Proclamations: ............................................................................................. 14

Recent Updates ......................................................................................................... 14
  Recent Updates: .................................................................................................... 15
  Main Menu: .......................................................................................................... 16
  Legislation: ............................................................................................................ 16
  Modify Time Period: ............................................................................................... 17

My Bills & Regs ......................................................................................................... 19
  Viewing Folders: .................................................................................................... 19
  Managing Folders: ................................................................................................. 19
Adding Legislation: ........................................................................................................ 21
Moving/Deleting Legislation: ...................................................................................... 21

**Search Engine** .......................................................................................................... 22
Performing a Bills Search: ............................................................................................. 22
Performing a Regulations Search: .................................................................................. 24
Saving a Search: ............................................................................................................. 28
Managing Saved Searches: ........................................................................................... 29
Resetting a Bill Search: .................................................................................................. 31
Search Tips: .................................................................................................................... 32

**Email Notifications** .................................................................................................... 32
Email Address: ................................................................................................................ 32
Affected Legislation: ....................................................................................................... 33
Pulse Folder: .................................................................................................................... 35
New Bills: ........................................................................................................................ 35
Weekly Bill Report: ......................................................................................................... 36
Emails and Recent Updates: ........................................................................................... 37
Known Issues: ................................................................................................................... 37

**Activity Report** .......................................................................................................... 37

**Preferences** ................................................................................................................. 38
Layout: ............................................................................................................................. 38
Table of Contents: .......................................................................................................... 39
Saved Logins: ................................................................................................................... 40

**Additional Support** .................................................................................................... 40
Introduction

Welcome to the Canadian Legislative PULSE website! Please take some time to read over this manual to get acquainted with the many features available to you. To return to this page at any time, simply click on the Help Topics link at the top of the table of contents.

Configuration Issues — Technical information, including supported browsers, the recommended screen resolution, configuration requirements, and known issues caused by third-party software.

Profile Passwords — Learn how to add a password to your profile for additional security.

Navigating the Site — How to use the tables of contents and menus to find what you're looking for.

Legislation — A guide to what all the colours and symbols mean, as well as information on the different views and other extra features available.

Recent Updates — This section explains how updates are tracked/indicated on the site, as well as how the time period for viewing updates can be modified.

My Bills & Regs — A guide to creating and managing your own folders for faster and simpler legislation tracking.

Search Engine — How to use the site’s powerful search engine to find legislation that's of interest to you.

Email Notifications — Information on the various update notifications available, as well as how to configure them.

Activity Report — Generate activity report detailing site access and email alerts.

Preferences — Read this guide to find out how you can configure the look and feel of the site to your own tastes.

Additional Support — Additional support and training available from LexisNexis®.
Configuration Issues

There are a few browser configuration issues that can prevent access to this site or cause it to not display properly. Please take the time to read over the following sections if you have encountered difficulties accessing the site, as it will better help our technical support personnel diagnose your problem should you still need to consult them.

Required Browser:

The Canadian Legislative PULSE website currently only supports Microsoft Internet Explorer browser versions 7.0 and above. LexisNexis does not support Netscape or other Web browsers, so the site will not necessarily work or look as intended if you attempt to access it using a non-Microsoft browser.

To check which version of Internet Explorer you are using, click on the Help menu at the top of your browser window. At the bottom of the menu you will see the option About Internet Explorer. Click on this link to open a new window with information about your browser. If you are using a browser version prior to 7.0, you will need to upgrade before the site will function properly. Please visit the Microsoft Internet Explorer Home Page for more information on upgrading your browser.

Logging In:

Please be patient when logging on to the site. If you have a slow internet connection it may appear that the site is not loading when in fact it is. If you cancel your request and try to log on again after the login script has updated your tracking time in the database, you will have to reset this time in order to see the most recent updates.

To prevent multiple requests being sent to the server, the Submit button is disabled after being clicked. If you cancel your login attempt by clicking the Stop button in your browser, you will have to refresh the login page to reactivate this button.

Although we have taken precautions to prevent multiple, simultaneous login requests from being made, there are situations we cannot prevent. For example, if you click more than once on a bookmark or page from your browser's History.

Bookmarking:

Please be aware that you can only bookmark the main login page (http://pulse.lexisnexis.ca).

Java Requirement:

In order to view the table of contents and other menus on the site, you must have a Java Virtual Machine (VM) installed on your computer. Microsoft stopped shipping their VM with the release of the XP operating system, so anyone who did not upgrade when switching to XP will need to download a copy of Sun's VM.
Configuration Issues

Note: The menus employed on the site are currently optimized to run under the Microsoft VM, but we will be upgrading them shortly to run better under Sun's VM.

JavaScript Requirement:

The dynamic content provided on the Canadian Legislative PULSE website requires that your browser have JavaScript enabled. The inability to follow links within the site, for example, is a strong indication that your browser does not have JavaScript enabled. The following instructions explain how to check and/or enable JavaScript in Internet Explorer:

1. From the Tools menu, select Internet Options... (Options on some browsers).
2. Click on the Security tab and check that the Internet zone has been highlighted.
3. Click on the Custom Level button.
4. Scroll down the list of settings in the new window until you find the section Scripting.
5. Ensure that the subsections Active scripting and Allow Programmatic clipboard access have been set to Enable.
6. Shut down and restart your browser to ensure that the changes have taken effect.

Cookies:

You must have cookies enabled in order to view the site. If you do not have cookies enabled, you will receive a message that your session has expired whenever you try to access the site. Cookies are only used to verify if your session is still active; they are not used to collect any information about you. The following instructions explain how to enable cookies for this site:

1. From the Tools menu, select Internet Options... (Options on some browsers).
2. Click on the Privacy tab.
3. In the Pop-up Blocker section at the bottom of the window, click on the Settings button.
4. Enter pulse.lexisnexis.ca in the Address of website to allow field in the new window and the click the Add button.
5. Click OK to exit any open windows and then shut down and restart your browser to ensure that the changes have taken effect.

Pop-up Windows and Pop-up Blockers:

We have tried to ensure that our pop-up windows do not get blocked by pop-up blocking software, but this is not possible in all cases. If a window does not open when you expect one to (for example when trying to view a footnote), please check that it has not been blocked by software on your computer.

Note: When upgrading to Windows XP® Service Pack 2, the new security settings can affect the ability of your browser to properly render the footnote windows on the site (in some cases they will open completely minimized, and in others not all of the text inside will be visible without scrolling). Please follow these steps to correct the issue:
1. From the **Tools** menu, select **Internet Options...** (*Options* on some browsers).
2. Click on the **Security** tab and then select the **Internet** zone.
3. Click on the **Custom Level** button.
4. In the new window that opens, look for the option **Allow script-initiated windows without size or position constraints** and make sure that it is **Enabled**.
5. Click OK to exit any open windows and then shut down and restart your browser to ensure that the change has taken effect.

**Firewalls:**

A problem exists in the ZoneAlarm Pro* privacy settings that forces the progress of legislation tables to be loaded in a separate window from the rest of the site. Although the ZoneAlarm software provides users the ability to exclude sites from adhering to the privacy settings, this option does not work. Consequently, in order to view the PULSE site properly, you must disable the privacy settings while surfing the site. The following steps explain how to disable these settings:

1. Double-click on the ZoneAlarm icon in your system tray to bring up the ZoneAlarm interface.
2. Click on the Privacy tab.
3. Ensure that both the **Cookie Control** and **Ad Blocking** features are set to **Low**.
4. Minimize the user interface and continue surfing the site.

No problems have been identified using firewall software from either Norton or Checkpoint.

**Note:** This problem does not affect users of the free ZoneAlarm software, as it does not include the privacy settings options.

**Proxy Servers:**

Some customers have experienced problems logging on to the site and accessing pages when surfing from behind a proxy server. If you experience difficulty accessing pages on the first attempt, but are able to get through to the server on a subsequent attempt, you should check if you are behind a proxy server. The following instructions explain how to check in Internet Explorer:

1. First ensure that there aren't any open browser windows and then open a new instance of Internet Explorer.
2. From the **Tools** menu, select **Internet Options...** (*Options* on some browsers).
3. Click on the **Connections** tab and then click the **LAN Settings...** button in the **Local Area Network (LAN) settings** section at the bottom of the window.
4. If there is a checkmark in the box beside the text "Use a proxy server for your LAN", your inability to access the site could be caused by your proxy server (leave this window open and continue on below).
If you are using a proxy server, then you should make the following adjustment to your browser settings to ensure that the browser does not attempt to access the PULSE site via the proxy server:

1. Click on the Advanced button in the Proxy Server section of the window you opened above.
2. At the bottom of the new window that will open is a section entitled Exceptions. Add the entry pulse.lexisnexis.ca to the box in this section (if there are already entries in this box, add a semi-colon to the end of the last entry and then add pulse.lexisnexis.ca immediately after).
3. Click OK to close any open windows and then shut down and restart Internet Explorer to make sure that the changes have taken effect.

Usernames / Passwords:

In order to access the Canadian Legislative PULSE site, you must first log on via the login page at http://pulse.lexisnexis.ca. You cannot bookmark pages within the site, as the server will not be able to validate your account. Attempting to do so will result in an "access denied", or "page not available" message being displayed in your browser window. In addition, if you have clicked the logoff button, you will have to log back in before you can continue surfing the site.

If you have an account to access the site, but are unable to log in, please read over the following troubleshooting steps before contacting LexisNexis® Customer Care:

1. Ensure that you have used the correct case to enter your username and password (all usernames and passwords are case-sensitive).
2. Check whether you can log in to the main menu from the login page at http://pulse.lexisnexis.ca (your session may have expired).
3. Verify that the username / password combination you are using is the same as the one that was sent to you in your confirmation email.

Screen Resolution:

It is recommended that you use a screen resolution of 1024x768 when surfing the site. The site will render correctly at an 800x600 resolution, but pages may not fit completely in the document window if you also have the table of contents open. If you must use an 800x600 resolution, it is recommended that you use a mouse with a scroll wheel.

Profile Passwords

As an extra level of security, users of the Canadian Legislative PULSE can add a password to their profiles to prevent unauthorized access. Once set, no one will be able to log on to the site or modify your settings without first entering the password.
Please note that the security offered for the site differs from that on the LexisNexis online site. There are no administrative users, and anyone with access to the site will still be able to add and remove profiles from the account they logged on under. Enhanced security similar to LexisNexis online may be introduced at a later time.

**Adding:**

When you first create a profile, you are presented with the option of creating a password:

```
Password: [ ]
Confirm Password: [ ]
```

Passwords must be at least six characters in length. It is also recommended that you use a combination of letters and numbers to make it harder for someone to guess. Retype your password in the confirmation field before submitting your profile. If there is a problem with the data you submit, you will need to retype your password into both fields before submitting your information again.

If you do not want a password on your profile, simply omit entering one — be aware that this means that anyone can log onto your profile and modify it!

If you are creating the default profile for a single-user account, entering a password will not provide any additional security until such time as you upgrade your license (single-user accounts bypass the profile selection page by default).

If you already have a profile and want to add a password to it, select your profile from the drop-down list on the selection page and click on the **Update** button in the **Manage Profiles** section.

![Password Entry](image)

Your profile information will appear in a new window with the password fields blank. Type your new password in the two required fields (see above) and click the **Update** button at the bottom of the form to set the password.

Now that you have created a password, you will have to enter it in the password field on the profile selection page before you will be able to continue into the site.

**Modifying/Deleting:**

To update or delete your information, select your profile from the drop-down menu on the profile selection page and click the **Update** button in the **Manage Profiles** section.

Instead of seeing your information displayed in a new pop-up window, you will now have to enter your password before you will be able to continue.
If you have forgotten your password, you will have to go back to the profile selection page and click on the retrieval link below the Submit button to have it emailed to you.

Please note that the password will only be sent to the email address currently specified for the profile. If your email address is out of date, you will have to contact LexisNexis Customer Care to retrieve your password.

After entering your password, the profile information page will appear. You can now change your existing password by entering your new choice in the appropriate fields:

To remove an existing password, enter the word none in both the password and confirmation fields. After clicking the Update button at the bottom of the form you will no longer have to use a password to log on.

**Navigating the Site**

The Canadian Legislative PULSE website is comprised of three distinct areas: a menu bar and header across the top of the page, a table of contents on the left-hand side of the screen, and the main document area.
The header and document pane are always visible, but depending on your preference the table of contents can be hidden (see the Preferences section of this guide).

The table of contents together with the main menu that is displayed when you first log in are the primary means of accessing the legislation on the site. The top menu bar, however, provides access to all the additional features available to aid you in your tracking of legislation.

**Main Menu:**

The main menu is a quick guide to what has changed on the site. Any time you see an Updated button with a yellow background (see graphic above), it means that the legislation for that jurisdiction has been updated since the last time you logged in. For a complete listing of updates since you last logged in, however, you would go to the Recent Updates page (see the Recent Updates section of the guide).

The menu also serves as a quick entry point to the legislation on the site if you prefer to hide the table of contents. Clicking on a button under the Current Session heading, for example, will always take you directly to the current session for that jurisdiction (no drilling down through the table of contents).

You can also access legislation in any other session by clicking on the button under the Previous Sessions heading for a jurisdiction.
Navigating the Site

Index of Alberta Bills

Please select a session from the list below to view the status of the Bills introduced.

<table>
<thead>
<tr>
<th>28th Legislature</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Session</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>27th Legislature</th>
</tr>
</thead>
<tbody>
<tr>
<td>5th Session</td>
</tr>
<tr>
<td>2nd Session</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>26th Legislature</th>
</tr>
</thead>
<tbody>
<tr>
<td>4th Session</td>
</tr>
<tr>
<td>1st Session</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>25th Legislature</th>
</tr>
</thead>
<tbody>
<tr>
<td>4th Session</td>
</tr>
<tr>
<td>1st Session</td>
</tr>
</tbody>
</table>

From this index you can then navigate to the session you wish to view (the same capability is available from within the current session, but for more information please see the Legislation section). If a session link has a yellow background, once again it means that updates have occurred since you last logged in.

The last group of links in the main menu is for proclamations from sessions that are not carried in the website (Other Proclamations). To keep you up-to-date on the coming into force of older bills, we have created this section of the site as a way for you to find out the latest proclamation information. If you are looking for information on a bill from a session that is carried in the Canadian Legislative PULSE, you will need to refer to the bill table for that session.

Table of Contents:

The table of contents simplifies the process of jumping between sessions and jurisdictions for bills, and years for regulations when surfing the site. Whenever you open a session, the table of contents will automatically synchronize itself to the document you opened.
You can then open any other session by clicking on it. You can also open any other jurisdiction or parliament and view the legislation in the same way. In other words, you don’t have to keep going back to the main menu each time you want to change jurisdictions.

**Note:** The sub-menus in the table of contents expand and collapse by clicking on the icon next to the folder.

If your preference is to have the table of contents hidden while surfing the site, it is still possible to jump quickly between sessions for any given jurisdiction. When a legislative session page is loaded in the document window, a new menu bar will appear at the top of it. Contained within this menu bar is a **Jump To** option.

The **Next Session** and **Previous Session** options can be used to quickly jump forward or backward through the legislation for that session. Please note that when you reach the first session in a legislature, clicking the Previous Session button will take you to the last session in the preceding legislature. Also, if the previous or next buttons are not available, it means that you have either reached the first session carried in the website or the current session respectively.

If you want to jump between non-successive sessions, clicking on the **Index of Sessions** option will take you to the index of all sessions for that jurisdiction. If you want to jump to a session in a different jurisdiction, however, you will first have to go back to the main menu (or re-display the table of contents).

**Menu bar:**

The menu bar provides quick and easy access to all of the features available on the site.
To expand a menu, simply click your mouse on the menu heading (once you have clicked on an expandable menu, you should be able to expand any other menu items in the menu bar by moving your mouse over them). The purpose of each of the options in the menu bar is as follows:

- **Home** — Returns you to the main menu page. (See above.)
- **Recent Updates** — Takes you to a page listing only the legislation that has been updated since you last logged in. (See the Recent Updates section for more information.)
- **My Bills & Regs** — Expands to show a listing of all your folders for quick access. Also provides the functionality for creating and deleting folders and tracking legislation. (See the My Bills & Regs section for more information.)
- **Search** — Expands to allow you to run a new or saved search and to manage your saved searches. (See the Search section for more information.)
- **View** — Expands to allow you to change the way the bills tables are displayed within the session view, and display or suppress the left hand table of contents. User information is also accessed here.
- **Tools** — Expands to allow you to choose your email notifications, generate individual activity report, and delete your saved login information.
- **Help** — Expands to provide access to additional documents and resources at your disposal.
- **Log Out** — Securely logs you off the site so that your current session cannot be used by someone else to access the site. Please note that if you do not use the log out button your session can remain active for up to thirty more minutes, regardless of whether you close your browser window.

## Legislation

### Layout of Bills:

Some users prefer to view bills in a progress table format. Others prefer to see all the information for a bill laid out in full. We've recognized that no one format is perfect for everyone, and so you have the option on the site of viewing bills in whichever format you prefer.

**Selecting a Layout**

The Layout submenu under **View** in the menu bar can be used to toggle between the two types of layouts.

<table>
<thead>
<tr>
<th>View</th>
<th>Tools</th>
<th>Help</th>
<th>Log Out</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bills Layout</td>
<td>x Progress Table</td>
<td>X Expanded Bills</td>
<td></td>
</tr>
<tr>
<td>Table of Contents</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The layout that is currently set as the default will have an **X** before it. To switch, simply click on the unchecked option. Switching layouts will immediately cause the current page to be updated.

For more information on customizing the site, please refer to the Preferences section of this guide.
Layout Comparison

Personal preference will inevitably determine your choice of one layout over another, but what follows is a brief comparison of the pros and cons of each.

**Progress Table** — The progress table layout is the more traditional of the two layouts, and what you will find on most government sites. It allows you to quickly scroll up and down through the bills, but some people find the text small and hard to read.

**Expanded Bills** — The expanded bill format is easier on the eyes, but more work to scroll through. It also tends to be more difficult to determine what jurisdiction and session you’re looking at on the recent updates, search result and folder pages (where multiple sessions on a page is common).

Accessing Legislation:

There are a number of different ways to access the legislation on the site, including via the main menu and table of contents. For more information on these methods, please refer to the Navigating the Site section of this guide.

Symbols and Colours:

All bills pages have a link to the legend for the site. You can also view the legend at any time by clicking on the **Legend** link under the Help menu.

The following table explains in detail what each colour and symbol means:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅</td>
<td>Is used as the background color in the Progress of Bills tables and behind the title row in the Expanded Bill layout to indicate that the bill was introduced by the government.</td>
</tr>
<tr>
<td>🔴</td>
<td>Is used as the background color in the Progress of Bills tables and behind the title row in the Expanded Bill layout to indicate that the bill was introduced by a Private Member.</td>
</tr>
<tr>
<td>✔️</td>
<td>Appears behind checkboxes to indicate that the bill has been added to one of your tracking folders.</td>
</tr>
<tr>
<td>🔄</td>
<td>Can appear as the background colour for any field and indicates that the information is new or has been updated since you last logged on.</td>
</tr>
<tr>
<td>🔴</td>
<td>Is used on search result as the background colour for a bill's title to indicate that the bill contains global amendments.</td>
</tr>
<tr>
<td>🎉</td>
<td>Indicates that there is additional information available for the given field. Clicking on the icon will open a new window displaying this information.</td>
</tr>
<tr>
<td>📚</td>
<td>Appears beside reading dates to indicate that an online version of that bill or regulation is available.</td>
</tr>
</tbody>
</table>
Menu Bar for Bills Pages:

Whenever you open a session, a new menu bar will appear at the top of the document window.

This menu bar provides easy access to the following useful features:

The **About** menu item provides access to additional information about the current session. The **Session Info** option opens a new window containing information session dates, whether the house is sitting, and when the site was last checked. The **Government Site** option opens the legislative assembly website for the jurisdiction in a new browser window.

The **Sort** menu item allows for bi-directional re-sorting of the legislation. You can chose to sort alphabetically or reverse-alphabetically by title, or in ascending or descending order by bill number or chapter number.

The **Jump To** menu item lets you quickly move to the next or previous session, and to jump to the index of all sessions for that jurisdiction (see the **Navigating the Site** section of the manual for more information).

The **Legend** option opens a new window with short descriptions of all of the colours and symbols used on the site.

The **Create PDF** option allows you to convert the current page to a PDF for printing. Use of this feature requires Adobe Acrobat Reader software, or an equivalent PDF viewer.
The **Help** option opens the online version of this guide in a new window.

**Note:** The menu bars at the top of the recent updates, search result and folder pages do not provide all of the functions described above.

**Full Text Links:**

Whenever you see a 📑 graphic beside a bill reading date, it means that you can link to the full text of the bill for that reading. The PULSE site only provides links to bills that are available on the government websites. For more information, please refer to the About the PULSE section of the website.

**Other Proclamations:**

As the Canadian Legislative PULSE archives only extend back to sessions that were open in 200, we created the Other Proclamations pages to provide information on Acts (or sections of Acts) from previous sessions that are proclaimed in force, starting January 1, 2000.

Acts on these pages are ordered alphabetically by title and numerically by statute year. If you do not know the Act name, the chapter number has also been included after the title.

**Note:** You will not find proclamations for legislation tracked on Canadian Legislative PULSE on these pages; proclamation information for these are posted under the Effective Date column of each bill/Act.

**Recent Updates**

One of the key features of the Canadian Legislative PULSE is the ability to track changes that have occurred between visits. Whenever you create an account or profile, a timestamp is added to our database. This timestamp is then incremented to the current time each time you log in thereafter. We are able to use the time difference between your logins to determine what information has been updated since your last login and highlight it for you.

**Note:** For the time of your last log in, check the information line at the top of the main menu and recent updates pages:

```
Updates to the site since 10:26 AM on Friday, February 08, 2013 are highlighted in yellow.
```
Recent Updates:

The fastest way to see all the bills or regulations that have been updated since you last logged on is to click on the Recent Updates option on the top menu bar.

Clicking on the Updated Bills or Updated Regulations link will take you to a page containing a consolidated listing of all the changes that have occurred since you last logged on. You can check each updated session for bills and year for regulations, and skim through all the legislation to find all the highlighted fields, but you will find checking this page much easier and faster!

Updated Bills

When you open the Updated bills page, you will notice that a new menu bar appears within the document window:

Clicking on the Legend option will open a new window that explains all the colours and symbols used on the site. Clicking on the Create PDF option will convert the page to a PDF for easier printing (you will need Adobe Acrobat Reader or an equivalent PDF viewer in order open the PDF generated). Finally, clicking on the Help option will bring you to this page.

Just below the menu bar you will see the start of the time period you are viewing updates from as well as a drop-down menu box:

The drop-down menu provides an easy way to jump to the updates for a specific jurisdiction. (Please note that if only one jurisdiction has been updated, this menu box will not appear.) Simply select the jurisdiction you wish to view from the available list and the page will immediately scroll to that section.

Updated Regulations

When you open the Updated Regulations page, the new menu bar includes the Legend and Help options.

For information on how to change the period for which you are viewing updates, please refer to the Modify Time Period section below.
For more information on what the highlighting in the legislation indicates, refer to the legislation section below.

Main Menu:

Another way to check what legislation has been updated since you last logged on is via the main menu. If no bills for a session or regulations for a year have changed, you will see the following used under each heading in the main menu:

View (for bills) View (for regulations)

If legislation has been updated, however, an update button will appear:

Updated!

If an update button appears under the Current Session, Other Proclamations, or Current Year headings, click on the button and it will take you to the page with the updated information (you will have to look for the updates manually, however). If the update buttons appears under Previous Sessions or Previous Years, you will be taken to the index page for that jurisdiction. You will then have to pick the updated sessions or years from the complete index (the sessions or years with a yellow background in the following graphic):

<table>
<thead>
<tr>
<th>37th Parliament</th>
</tr>
</thead>
<tbody>
<tr>
<td>5th Session</td>
</tr>
<tr>
<td>4th Session</td>
</tr>
<tr>
<td>3rd Session</td>
</tr>
<tr>
<td>2nd Session</td>
</tr>
</tbody>
</table>

(for bills)

<table>
<thead>
<tr>
<th>2010s</th>
</tr>
</thead>
<tbody>
<tr>
<td>2009</td>
</tr>
</tbody>
</table>

2008 2007

2009 2008 2007

(for regulations)

For more information on what the highlighting in the legislation indicates, refer to the next section.

Legislation:

Whenever you see a field in the bills table, expanded bill layout, or regulations table with a yellow background, it means that the information for that field is either new or has been updated since the last time you logged on. Please read over the following items for a more complete explanation of what the various kinds of highlighting you’ll encounter mean:
A yellow background behind any field normally indicates new information. Exceptions are the proclamation information in the expanded bill layout (which may indicate the information has been updated) and the inclusion of the amended after second reading markers (when that information is not available at the same time as the reading date).

If a footnote appears in yellow, it means that the information is either new or has been updated. If the field with the footnote had also been updated, the background for it would also be yellow (see the preceding item for examples). In the expanded bill layout, however, the field name will always be highlighted in yellow if either the field or footnote information has been updated.

When a bill is first introduced, only the first reading date field will be highlighted in yellow (in order to allow you to easily determine by the background colour if the bill is a government bill or private member’s bill).

There is no overlap on the highlighting of information. In other words, a field is only highlighted in yellow if it has been updated and any footnotes associated with it will only appear in yellow if they have been updated. This separation allows you to better determine if a field has been highlighted because it has progressed through another stage of the legislature or because some new information about the bill has been added to a footnote.

**Modify Time Period:**

You can change the period you are viewing updates from at any time by clicking on **Modify Time Period** under the **Recent Updates** menu item.

The following form will open when you click on this link:
This form can be used to set your update tracking time period to whatever new date you wish (and even whatever hour, minute, and second if you want). This feature is especially useful, for example, if you logged out without checking all the updates on the site. The next time you log in you can reset the time back as far as you need to re-highlight the missed updates.

**Note:** The default when using this form is to not update your timestamp in the database. In other words, the next time you log in you will not see all the updates from the time you specified in the form again (only the updates between your last login and the current date). If you want to change your timestamp so that the time you specify in the form will also appear as the last time you logged in when you next log on to the site, you need to select the **Permanent** option in the form.

You can also use this form to stop your timestamp from being updated when you log in. To make your timestamp static, change the option **Update tracking time when you log in** from Yes to No. Changing this setting will allow you to see a continuous record of changes from a given date.

Please make note of the following instructions when changing the automatic update of your tracking time:

- You do not have to specify a new tracking time to change your update preference. Simply change the setting and click the update button.
- If you also want to change the tracking date, make sure that you select the **Permanent** option. If you leave the setting as **Temporary** your static login time will remain as your last login time.
- Conversely, you can change your timestamp without affecting your static login time by leaving the **Temporary** setting selected.
My Bills & Regs

The My Bills & Regs section was designed to facilitate your tracking of legislation on the site. Located in the top menu bar, this feature allows you to create virtual folders that can be used to store legislation.

When an account/profile is first created, a default folder called "My Bills" is automatically created for you. You are free, however, to delete or rename this folder. You are also not limited to using just this one folder to store legislation — there is no limit imposed on the number of folders you can create.

Viewing Folders:

All of your folders are listed under the “Pulse Folders” section in the My Bills & Regs menu (there are two folders for the account in the graphic below, "My Bills" and "Canada." To view the contents of your folders at any time simply click on the corresponding menu item.

Managing Folders:

As noted above, there is no limit on the number of folders you can create. To create a new folder, select the Create option under the Manage Folders sub-menu.

You will then be prompted to enter a new name for your folder. Once you click the Create button the following window will prompt you to create an email notification for the folder you just created. This is an important step; if a notification is not set up for the folder you will be able to add legislation to the folder and able to view changes to its contents, but you will not receive an email notification when there is a change to a bill or regulation you are tracking.
If you choose to add an email notification for the folder, the next page will prompt you to choose a time you would like to have the folder checked, and to fill in the email address of where you want the notification sent.

You can also rename and/or delete your folders from the same sub-menu. If you choose to delete a folder, please note that any legislation still contained in it will be deleted as well. Also, if you delete all your folders some options on the site will obviously not be available to you until you create a new one (such as the ability to store legislation and use the My Bills email notification feature).
Adding Legislation:

You can add legislation to your folders anywhere that it is available on the site. To add a bill, click on the checkbox next to it.

Once you have checked off all the bills you want to add to a given folder, select the folder from the Add to option under the Checked Items sub-menu to include them.

Once you have successfully added a bill to a folder, the background behind the checkbox will change to light green.

Please note the following guidelines when adding legislation to folders:

- The same legislation can be added to more than one folder. If you want to track the same bill in different folders, just add it to each folder separately.
- For pages that contain multiple sessions of legislation (search results, recent updates), you do not have to update your folder for each session. Legislation from any session can be added at the same time.
- You must add any legislation you want to track to a folder before changing pages. Once you switch pages any checked bills on the previous page are lost.

Moving/Deleting Legislation:

To move or delete legislation from a folder, first open the folder containing the legislation. Now, in the same way that you added the legislation, click on the checkbox next all the bills you wish to move or delete. Finally, select the new folder to move the legislation to from the Move To option, or select the Delete option to remove the bills from the folder.

**Note:** The move and delete options are only available when viewing a folder page. If you attempt to use them for legislation anywhere else on the site, you will receive the following warning:
This security measure ensures that legislation stored in more than one folder is not moved/deleted from the wrong folder.

**Note:** If you want to remove all the legislation from a folder, it may be faster just to delete and recreate the folder than to click on all the checkboxes and use the Delete option.

---

**Search Engine**

The search engine on the Canadian Legislative PULSE website was designed to make locating legislation in any jurisdiction and from any session or year as simple as possible. What used to take hours can now be done with a few simple clicks of your mouse.

**Performing a Bills Search:**

To run a bill search for the first time, select the Search Bills/Acts option from the Search menu.

![Search Engine User Interface](image)

The following search form will then open in the document window:
You will also notice that the table of contents appears, regardless of what your preference is set to. See below for more information on how to use the table of contents in your search.

**Selecting a Search Type:**

There are four types of searches available to you:

- **Bill Title** — allows you to search for legislation by words or phases found in the title of the bill.
- **Bill #** — is a simple search for returning bills by their number.
- **Chapter #** — allows you to easily find bills/Acts by the chapter number and statute year.
- **Statutes Affected** — allows you to find bills based on what statutes they amend/affect.

The two most commonly used search types are Bill Title and Statutes Affected. Bill Title is particularly useful if you know only part of a title of a bill you need to look up, whereas Statutes Affected is ideal for finding all legislation that amends any Act you need to keep up-to-date on changes to.

To change the type of search performed, simply click on the button beside the new search type. The selector button will change position to indicate the new search type.

Depending on which type of search you select, the form may change slightly. If you select the **Bill Title** or **Bill #** search options, there is only one input field. If you choose the **Chapter #** option, however, a second field will appear.
If you want to limit your chapter number search to specific years, enter those years in the new input field (the default text will automatically disappear when you click on the input box). Likewise, if you specify the Statutes Amended option, another new criteria field will appear.

There are times when a bill specifies a change that could affect numerous pieces of legislation without specifying all of those Acts by name (for example, a section that changes all instances of "Newfoundland" to "Newfoundland and Labrador" wherever it appears in any Act. These amendments are listed as global amendments.

Consequently, when you use the Statutes Amended option, the default is to include all bills with global amendments in the results. The default is to exclude global amendments, to include them, click on the No button.

Performing a Regulations Search:

To run a search regulations search for the first time, select the Search Regulations option from the Search menu.

The following search form will then open in the document window:
Selecting a Search Type:

There are four types of searches available to you:

- **Reg Title** — allows you to search for regulations by words or phases found in the title of the regulation.
- **Reg #** — is a simple search for returning regulations by their number.
- **Act Name** — allows you to easily find regulations associated with a particular Act.
- **Regs Amended** — allows you to find amendments to a particular regulation.

Search Syntax:

The search engine understands two types of input: keywords and phrases (the distinction between the two is the use, or lack, of quotes). The search engine will automatically break up your input wherever a space character is found, unless that space is within quotes. This means that the search engine would treat the input **tax act** as two distinct keywords (**tax** and **act**) and will try to match accordingly. If you were to enter "**tax act"**, however, the search engine would try to match the complete phrase rather than the individual words.

By default, the Boolean **and** operator is applied to all keywords and phrases entered. Using the above example, the search engine would return only results that contained both the words **tax** and **act**. Please see the section on Boolean operators below for more information on how to change this default behavior of the search engine.

Word boundaries are also enforced by the search engine. If you enter the word **tax**, only matches with "tax" will be returned (i.e., taxation, taxable, taxed, etc. will not be returned as
matches). To match variable beginnings or endings on a word, please see the section on wildcard matches below.

**Note:** All searches are case-insensitive.

### Boolean Operators

Although the default is to use the **and** operator between keywords and phrases, you can specify any of the following operators in your search string to change this behavior:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>and</strong> &amp; &lt;space&gt;</td>
<td><em>business corporations</em>  &lt;br&gt; Both words must be found in the result. Leaving a single space between words automatically indicates an &quot;and&quot; relationship.</td>
</tr>
<tr>
<td><strong>or</strong></td>
<td>*business</td>
</tr>
<tr>
<td><strong>not</strong> ^</td>
<td><em>business ^ corporations</em>  &lt;br&gt; The first word must be in the result and the second word must not. Use the caret symbol (^) or the word not to specify a &quot;not&quot; relationship.</td>
</tr>
</tbody>
</table>

### Wildcard Searches

Wildcard searches can be used to increase the matching power of your search. Where the search engine will normally apply word boundaries to your search terms, adding in a wildcard will allow a greater number of variations to be matched.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>The single character wildcard (?) can be used to replace a single character anywhere in a word. You can use as many of these wildcards as you like, but each must match a character in order to return a result: &lt;br&gt; tax?? — will match taxed or taxes but not tax or taxing. &lt;br&gt; w?s? — will match wash or wise.  &lt;br&gt; When a single character wildcard matches a space, the search engine</td>
</tr>
</tbody>
</table>
Selecting Jurisdictions/Sessions for bill/Act searches:

There are three options when it comes to selecting which jurisdictions and sessions to search.

<table>
<thead>
<tr>
<th>Search in:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ All Current Sessions</td>
<td>Allows you to easily search all the current sessions. The advantage of using this option instead of checking off all the current sessions in the table of contents (aside from speed), is that if you save your search it will always search the most current sessions each time you run it.</td>
</tr>
<tr>
<td>☑ All of the Table of Contents</td>
<td>Ensures that all sessions will be checked. The other way to search the entire contents of the database is to select the All items checked in Table of Contents option and select all the sessions (by checking off the checkbox beside the Home heading) or by leaving all the checkboxes in the table of contents unchecked.</td>
</tr>
</tbody>
</table>

The All Current Sessions option allows you to easily search all the current sessions. The advantage of using this option instead of checking off all the current sessions in the table of contents (aside from speed), is that if you save your search it will always search the most current sessions each time you run it.

There are actually two ways to search all of the bills in the database. Selecting the All of the Table of Contents option ensures that all sessions will be checked. The other way to search the entire contents of the database is to select the All items checked in Table of Contents option and select all the sessions (by checking off the checkbox beside the Home heading) or by leaving all the checkboxes in the table of contents unchecked.
Selecting the All of the Table of Contents option also allows you to quickly and easily search different jurisdictions and sessions at the same time. You can check off any checkboxes in the table of contents to include those sessions in your search.

Please read over the following tips and tricks to further simplify your searching using this option:

- To select the entire table of contents, click on the checkbox next to the Home heading.
- To select all the sessions for a jurisdiction, click on the checkbox next to the jurisdiction's name. You do not have to expand the branch of the table of contents and select each checkbox. The same method can be used to select all of the sessions under a given legislature.
- To clear all the selected checkboxes and start again, click on the checkbox beside the Home heading to select the entire table of contents and then uncheck the same checkbox to remove all the checks.
- To expand/contract the entire table of contents, click on the globe next to Home heading.

Note: The Other Proclamations documents do not have checkboxes next to them because they are not searchable. If you are looking for proclamation information for legislation not carried in the Canadian Legislative PULSE, you must check these pages the old-fashioned way.

Saving a Search:

Whenever you perform a new search you have the option to save it so it can be rerun later, even if it doesn't produce any results. There is no limit to the number of searches that can be saved.

To save your search, look for the Save Search option in the new menu bar that opens on the results page.

Clicking on this item will open the following window, where you can specify additional information about your search:
By default, the search words you used are displayed as the name for your saved search. If you change this name, be sure to change it to something meaningful as this is what will be displayed under the Search menu heading when you go to rerun your saved searches.

You also have the option of specifying a short description of the search to remind yourself later about any important details; it is advisable that you enter the your search options in this field including Search type (Bill Title, Bill #, Chapter #, or Statutes Amended) and the Search in information (All Current Sessions, All of the toc, or All items checked in the toc) as this information will not be displayed later. Whatever text you enter in this box will be the title of the search. Once you're done, click on the Save button to permanently save your search. When you close the save search window, the top menu will automatically update to reflect your new saved search (see the above graphic).

Once you've saved a search you can rerun it at any time by selecting it from the Search menu.

Managing Saved Searches:

Although you cannot go back and modify the syntax or sessions for a search, you can rename your searches and/or modify the description you gave to them (this is especially useful if you save a search that is very similar to a previously saved search and you want to better distinguish between the two). To modify any of your saved searches, select the Manage Saved Searches option from the Search menu.
Clicking on Bill Searches will open the following window:

Select the search you want to modify or delete from the drop-down menu box. Clicking on the **Delete** button at this point will remove the saved search. Clicking on the **View** button will load the following form:
You can now change the name and description to whatever you prefer. When you are done, click on the **Modify** button again to update your information.

When you are finished modifying/deleting your saved searches, close the window to update the menu bar on the main site. You may be prompted that the browser is trying to refresh the current page. It is safe to click the Retry button. If you get this warning and click Cancel, your information will still be updated but the site will not reflect the change.

### Resetting a Bill Search:

The last bill search you performed is stored for as long as you keep surfing the site. This feature allows you to return to the search page and rerun your last search with different criteria (or with the same if you want to check your results again).

To restore your last search, click on the **Modify** button on the search form. The form will then reset itself to reflect your last search. Please note, however, that any items in the table of contents cannot be reset; you must change the selected sessions manually if you have changed the checkboxes since you last ran a search. Also, each time you run a new search, the preceding search criteria is lost.

**Note:** These saved searches do not last between visits to the site, like real saved searches. If you want to permanently save a search, use the saved search option as soon as you finish your search.
Email Notifications

Search Tips:
The following tips will help you maximize your use of the search engine:

- Narrow the search criteria to a specific jurisdiction and session. The search form can be used to search all jurisdictions and sessions, but it is not the most efficient way to search if you are only interested in one jurisdiction.
- Use a phrase search when checking for legislation that amends a specific Act (i.e., use "Workers' Compensation Act" instead of Worker or Compensation).
- Avoid searching for common phrases in bill titles (e.g., "amendment act" or "an act to amend"). The more unique keywords you use, the better focused your results will be.
- Include a statute year when searching by chapter number.

Email Notifications

For your convenience, the Canadian Legislative PULSE provides four email notifications for keeping abreast of updates to the site. Located under the Tools menu heading, these notifications can be tailored to suit your tracking needs.

Email Address:
Before you can configure the email notifications, you must first supply a valid email address. For your convenience, a form to update your email address has been included at the bottom of every notification page.

To change your email address at any time, simply amend the information in the text box and click the Change button. Please note that these notification emails are only available for PULSE subscribers. You cannot specify multiple recipients in the email address field, nor can you specify different email addresses for the different notification types.
Affected Legislation:

This email notification alerts you whenever a new bill or regulation is introduced that amends an Act (or regulation under that Act) matching your pre-saved criteria (including additional Acts amended by a bill if added on a subsequent reading). This alert is particularly useful if there are specific Acts that you need to keep up-to-date on but don't have the time to log in and search the site on a daily basis.

To create an alert, click on the Affected Legislation menu item. The following form will be loaded:

![Affected Legislation Notification Form]

To start, select the time(s) of day when you would like to be notified of any matching bills or regulations by ticking off checkboxes at the top of the form. When you click on the Update button at the bottom of the table the background colour behind the selected times will turn green:

![Updated Alert Times]

You can come back to this form at any time and change the time settings by adding or removing checks. Always remember to click the Update button to make your changes permanent!

All that is left now is to enter the search criteria to match Act names against. To enter this information, click on the Add button in the second table to open the following form:
Enter a match string in the "Act name" field and then select the jurisdiction(s) you want to receive alerts for (please refer to the Search Engine section of the guide for the pattern matching and Boolean operators that can be used).

If you subscribe to both the bills and regulations services, you can then select whether to apply the pattern you've entered against either type of legislation or both. (If you only subscribe to bills, you will see but not be able to alter this field.)

For example, to be informed about any regulations and bills in British Columbia or Alberta affecting Acts with the phrase "taxation act" in their title, you would fill out the form as in the following image:

Click on the Add button at the bottom of the form to add your new saved match pattern. The form will not close after successfully adding a new pattern in order to allow you to keep entering more patterns. Once you have finished, click the Close button to return to the original page. This page automatically updates after each new pattern is added, so you should see your new saved criteria right away:
If you made a mistake entering the match string, or want to change jurisdictions or the scope of legislation to apply it to, tick the checkbox beside the pattern and click the Modify button at the bottom of the table. Please note that you can only edit one pattern at a time.

You can delete patterns by ticking off the appropriate checkboxes and clicking the Delete button at the bottom of the table. Removing all alert times will not remove your saved patterns; they will remain saved until you re-enable your alert or delete them.

**Pulse Folder:**

If you are tracking legislation using the site's My Bills & Regs folder feature, you can use the PULSE Folder notification to keep abreast of its progression (for bills) and of changes to the proclamation and other fields (bills and regulations). Click on the PULSE Folder menu item to open the following form:

![Pulse Folder(s) — Email Notification Options](image)

This form allows you to pick the times during the day when you would like to be notified if any updates have occurred. For example, if you select 7am to be notified of changes, each morning at seven the legislation in that folder will be checked to see if any changes have occurred since 7:00 the previous morning. Likewise, if you were to pick 7am and 2pm, the check at 7:00AM would scan for updates since 2:00PM the previous day and the check at 2:00PM would scan for updates since 7:00 that morning.

You are not required to receive updates for all your folders; you only have to select times for the folders you want notifications for:

![Pulse Folder(s) — Email Notification Options](image)

To stop receiving updates, deselect all the checkboxes for a folder and click the Update button.

**New Bills:**

The New Bills notification, as its name implies, can be used to be alerted whenever new bills are added to the site.
Like the PULSE Folder notification, you are free to choose which jurisdictions to receive updates for and how often during the day you want to check. If you want to receive notifications for all jurisdictions, select times from the All Jurisdictions option at the top of the form. If you set this option, you do not have to set each of the individual jurisdictions as well. You can, however, mix and match.

For example, if you wanted to check all jurisdictions once each morning, you could set the 7am time for All Jurisdictions. If you also need to keep on top of Ontario bills, you could also set the Ontario option for 12pm and 4pm. You will not receive duplicate emails if you turn on the All Jurisdictions option and any of the individual jurisdictions at the same time. Once an email has been sent, your notification information is updated. So, using the preceding example, the 7am check of all jurisdictions would only check for new legislation from 4pm the day before (as that was the last time Ontario was checked).

To stop receiving email updates, deselect any checked times for a jurisdiction and click the Update button at the bottom of the form.

**Weekly Bill Report:**

The Weekly Bill Report is an rtf summary of all the changes that have occurred to bills on the site during the preceding seven-day period.
To enable these emails, first select the **Yes** option under the Notify heading. You can then change the day of the week to receive the reports, or click the Update button to opt for the default of Mondays.

At 7am on the day you selected an rtf file will be emailed to you containing all the changes that have occurred since 7am on that day in the preceding week. In simpler terms, if you receive the report on Monday, May 8, it will reflect all changes that occurred between 7am on Monday, May 1 and 7am on Monday, May 8.

To turn off this option, change the Yes setting back to No and click the Update button.

**Emails and Recent Updates:**

The email notifications do not have an impact on the regular tracking that occurs on the site. They are simply a record of changes that have occurred. Consequently, changing your tracking time for the site will have no impact on the updates you receive. Likewise, receiving updates will not change the highlighted information you'll see the next time you log in.

**Known Issues:**

Mail servers can be very sensitive about what they consider spam mail. LexisNexis will attempt to notify you if an email bounces back to our mail server, but some servers will automatically junk any mail considered to be spam without notice. If you know that you should have received an update but have not, please check with your email administrator first to ensure that a spam filter is not the cause. A spam filter exception may be the only way we can get emails through to you.

**Activity Report**

Access the Activity Report page under the Tools/Generate Reports tab.
The report will show the date and duration of site access as well as the dates of all email alerts sent to you by the PULSE.

Preferences

Layout:

There are currently two sections in the View menu that allow you to personalize your experience. The first of these options that we'll deal with is the Bills Layout sub-menu.

When you first create an account, Progress Table is set as the default (as evidenced by the checkmark next to the setting). This setting means that all legislation will appear in progress
table format, regardless of the page (see the Legislation section of this guide for the differences between the two layouts). To change this preference at any time, simply click on the unchecked option.

If you are viewing a page with legislation at the time you change this setting, the page will automatically be refreshed to reflect the new preference. You may, on occasion, be prompted by your browser with the following message:

This message will appear if, for example, you had just run a search. All it is telling you is that the page you are trying to refresh was created when you submitted a form. For all pages on the Canadian Legislative PULSE that generate this message, it is okay to click Retry. If you click Cancel, your preference will still be changed, but the current page will not be updated.

Once the pages have refreshed, you can click back on the Options menu to verify that your preference has been updated. This setting is saved between visits to the Canadian Legislative PULSE website, so the next time you log in you will not have to change it again.

Table of Contents:

The table of contents option allows you specify whether you would prefer the applet to be visible or hidden as you surf the site. This option is remembered on subsequent logins.

If you are using a low screen resolution (800x600), you may want to disable the table of contents so that you can view more information. If you are using a higher resolution (1024x768) it is recommended that you not hide the table of contents, as almost all content on the site should fit on screen even with the table of contents visible.

Please note that in order to refine your searches to specific jurisdictions/sessions, the table of contents will need to be visible.
Saved Logins:

The final setting that we'll deal with in this section is the Saved Login option.

If you chose at any stage during the login process to save your information, you may have wondered how you could undo that setting if your login info changes (or if you don't want people accessing your computer to use your account). Clicking on the Delete Cookie option will automatically delete the saved information for you. Instead of having to hunt down the cookie on your computer, or resort to deleting all your cookies just to remove this information, you now have this simple alternative to secure your account.

Additional Support

If you have not been able to find an answer to your problem in this guide or if you would like additional training on the Canadian Legislative PULSE or other LexisNexis® products, please contact the appropriate department below:

- For technical problems, LexisNexis Customer Care can be reached by email at service@lexisnexis.ca or by phone at 1-800-387-0899.
- For training information, please visit the LexisNexis Customer Training Centre at http://www.lexisnexis.ca/en-ca/training/training-overview.page.
- To subscribe to the Canadian Legislative PULSE, call LexisNexis Customer Care at 1-800-387-0899 or contact your Account Manager.